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Software (Network Configuration and Address Book Editor)
Operating Instructions

For Digital Imaging Systems

Before using this software, please carefully read these instructions completely and keep these operating 
instructions in a safe place for future reference.

English
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The following trademarks and registered trademarks are used throughout this manual:

Microsoft, MS-DOS, Windows, Windows Server, Windows Vista, PowerPoint, Excel and Internet 
Explorer are either registered trademarks or trademarks of Microsoft Corporation in the United 
States and/or other countries.
Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.
i386, i486, Intel, Celeron, Intel Centrino, Pentium and Itanium are trademarks of Intel Corporation 
and its subsidiaries.
IBM and AT are the trademarks or registered trademarks of International Business Machines 
Corporation in the U.S. and other countries.
The USB-IF Logos are trademarks of Universal Serial Bus Implementers Forum, Inc.
Mac, Mac OS, Macintosh, True Type and Apple are trademarks of Apple Inc.,registered in the 
U.S. and other countries.
Novell, NetWare, IntranetWare, NDS are registered trademarks of Novell, Inc. in the USA and 
other countries.
PEERLESSPage™ is a trademark of the PEERLESS Systems Corporation; and,
PEERLESSPrint® and Memory Reduction Technology® are registered trademarks PEERLESS
Systems Corporation; and, COPYRIGHT ©  2005 PEERLESS Systems Corporation.
COPYRIGHT ©  2005 Adobe Systems Incorporated. All Rights Reserved; and 
Adobe® PostScript® 3™.
Universal Font Scaling Technology (UFST) and all typefaces have been licensed from Monotype
Imaging Inc.
Monotype® is a registered trademark of Monotype Imaging Inc. registered in the U.S. Patent and 
Trademark Office and may be registered in other jurisdictions. 
ColorSet™ is a registered trademark of Monotype Imaging Inc. registered in the U.S. Patent and 
Trademark Office and may be registered in other jurisdictions. ColorSet™ Profile Tool Kit, Profile 
Studio and Profile Optimizer are trademarks of Monotype Imaging Inc. and may be registered in 
certain jurisdictions.
COPYRIGHT ©  2007 Monotype Imaging Inc. All Rights Reserved.
PCL is a trademark of Hewlett-Packard Company.
Adobe, Acrobat, Adobe Type Manager, PostScript, PostScript 3 and Reader are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 
countries.
Application software for this device contains a number of programs licensed under the terms 
of the GNU Lesser General Public License and other open software. For more details and 
applicable license thereof, please refer to the Read Me file for the software.
All other product/brand names, trademarks or registered trademarks identified herein are the 
property of their respective owners.
In these Operating Instructions, some ™ and ® marks are omitted from the main text.

©  Panasonic Communications Co., Ltd. 2005-2008
Unauthorized copying and distribution is a violation of law.
Panasonic accepts no liability for any effects resulting from the use of this software or manual.
Published in Japan.

The contents of these Operating Instructions are subject to change without notice.
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General Description
The Network Configuration Editor uses the FTP or HTTP/HTTPS protocol to edit settings for all functions in 
connected devices (printer, copier, scanner, or fax).
The Address Book Editor manages the IP addresses, telephone numbers, and similar settings for devices 
connected to the network (printer, copier, scanner, or fax).

 The Network Configuration Editor displays and edits device (printer, copier, scanner, or fax) settings.
 The Address Book Editor displays and edits device (printer, copier, scanner, or fax) address settings.

NOTE The Network Configuration Editor and Address Book Editor can be started from the device list in the 
Device Explorer.
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using the FTP or HTTP/HTTPS protocol. The desired device is first selected from the device list of the Device 
Explorer, and then the Network Configuration Editor, or Network Address Book Editor can be started.

Note:
The following screen is shown when retrieving the data from a device if the software modules have not been installed to your 
PC. Click the Update  button to download the modules from the Web site.

The compatible devices are listed in the Supported Models List.

Select Help  Supported Models... to open the list. You can access the Web site by clicking the Update  button on 
the window.
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System Requirements
Personal Computer : IBM® PC/AT® and compatibles (CPU Intel® Pentium® 4 1.6 GHz or greater is recommended)

Operating System : Microsoft® Windows® 2000 operating system (Service Pack 4 or later)*1, 
Microsoft® Windows® XP operating system (Service Pack 2 or later)*2, 
Microsoft® Windows Server® 2003 operating system (Service Pack 1 or later)*3, 
Microsoft® Windows Vista® operating system*4,
Microsoft® Windows Server® 2008 operating system*5 .

* The following Operating System is not supported :
  Microsoft® Windows Server® 2003 Enterprise Edition for Itanium®-based systems, 
Microsoft® Windows Server® 2008 Enterprise Edition for Itanium®-based systems.

Interface : 10Base-T/100Base-TX/1000Base-T Ethernet Port, USB Port, Parallel Port
(The interface that can be used is different depending on the model)

CD-ROM Drive : Used for installing the software and utilities from the CD-ROM.

: 512MB or more

*1 Microsoft® Windows® 2000 operating system (hereafter Windows 2000)
*2 Microsoft® Windows® XP operating system (hereafter Windows XP)
*3 Microsoft® Windows Server® 2003 operating system (hereafter Windows Server 2003)
*4 Microsoft® Windows Vista® operating system (hereafter Windows Vista)
*5 Microsoft® Windows Server® 2008 operating system (hereafter Windows Server 2008)

Free Disk Space : 300 MB or more (For installation and work space, not including storage space)

Microsoft® Windows® 2000 operating system  
Microsoft® Windows® XP operating system
Microsoft® Windows Server® 2003 operating system
Microsoft® Windows Vista® operating system
Microsoft® Windows Server® 2008 operating system

: 256MB or more
System Memory : Recommended Memory for each OS:

: 1GB or more

Application 
Software

: Microsoft® Internet Explorer® 6.0 Service Pack 1 or later, 
Microsoft® .NET Framework Version 2.0, 

.NET Framework Version 2.0 Language Pack .



7

Sy
st

em
 R

eq
ui

re
m

en
ts

Memo



8

O
pening C

onfiguration/
A

ddress B
ook Editor

Opening Configuration /Address Book Editor
Start the Device Explorer by clicking the Start menu, and select All Programs (Programs for Windows 
2000)  Panasonic  Panasonic Document Management System  Device Explorer. 

The Device Explorer opens.
Right-click on the device on the list, and then select either Open Network Configuration Editor, or Open 
Network Address Book Editor.

Note:
If the desired device does not appear on the list, confirm the Community Name set in the Device Explorer. 
Refer to "Operating Instructions (For Device Explorer and Embedded Web Server)".
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Your selection, the Network Configuration Editor, or Network Address Book Editor opens, and displays 
the retrieved data from the device.
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Main Window
Network Configuration Editor

Help Bar Status Indicator

Network Address Book Editor

Help Bar Status Indicator

Help Bar : Input or operation guide help is indicated.

Status Indicator : Communication status and the latest communication results are indicated.

Menus and Icons

Menu
Toolbar 

Icon
Description

File
New Creates a new blank file.

Open Opens an existing file.

Close Closes the active file.

Save Saves the settings to a file with its current name.

Save As Saves the settings to a file with a new designated file name.

File Information Displays the device information, or used to edit the IP address list.

Font Selects the printing report(s) font.

Print Prints the active folder content.

Delete Deletes the file.

Export Exports the active folder contents to a text file.

Import Imports the active contents from a text file.

Exit Shuts down the application.

Quit Closes the active window without saving the data.
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Menu Toolbar 
Icon Description

Edit Cut Removes selected lines and places them on the clipboard.

Copy Copies selected lines to the clipboard.

Paste Pastes the contents of the clipboard at the insertion point of the line.

Insert Line Inserts a line at the insertion point of the line.

Delete Line Deletes a line at the deletion point of the line.

Find Parameter Searches for specified text in the active file.

Set to Default Sets all settings of the active folder to their default values.

View
List Mode Displays list mode.

Detail Mode Displays detail mode.

Sort Selects the display sort mode.

Toolbar Shows or hides the Toolbar.

Status Bar Shows or hides the Status Bar.

Font Selects the display font.

Transfer
Retrieve Retrieves the current settings from the device.

Write
Writes the settings to the device.
Selects either "All Data" or "Department Codes" only.

Display Log Displays the transfer log.

Tools
Device Address List Opens the Device Address List dialog.

Device Group List Opens the Device Group List dialog.

Options  General Opens the General settings dialog.
Options  FTP 
Configuration
Options  HTTP 
Configurations

Opens the FTP Settings dialog.

Opens the HTTP/HTTPS Settings dialog.

Window
Tile Horizontal

Arranges and reduces all opened windows to fit into one window 
horizontally.

Tile Vertical
Arranges and reduces all opened windows to fit into one window 
vertically.

Cascade
Arranges all opened windows to overlap in a way that only the title 
bar of each window is visible.

Close All Closes all open windows.

Help Help Topics Displays Help Topics.

Supported Models Displays a list of supported models.

About
Displays the information about Network Configuration Editor / 
Network Address Book Editor.
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Basic Operation
Retrieve Data

When the Network Configuration Editor, or the Network Address Book Editor is started from the 
Device Explorer, it connects to the device, retrieves the data, and then displays it automatically.
The processing status is indicated in the bottom right side of the window.

Status Indicator

Note:
If the device password was changed from the default value, data cannot be retrieved. 
Ask your administrator for the current password.

If you want to retrieve (refresh) the data from the device again, click the  icon, or select Retrieve from 
the Transfer menu.

Note:
While the device is operating (copying, printing, etc...), attempts to retrieve the data will generate a Retrieving error 
message. Try again later after the device goes into the standby condition.



Edit Data

 Network Configuration Editor

Modify parameters using the Network Configuration Editor.
When a function is chosen in the left pane of the window, the display on the right pane changes.

Note:
Fields on the left show what items have been changed.
*: An item which is different from the default setting.
#: An item that has been changed.

 Network Address Book Editor

Modify, add, or delete Address Book entries using the Network Address Book Editor.
From the left pane window, choose the type of Address Book to view or use.
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Write Data

If you want to record the edited data to the device, click the  icon, or select Write from the Transfer menu.

Select the Yes  button to start writing to the device.

Status Indicator

The processing status is indicated in the bottom right side of the window.

Note:
While the device is operating (copying, printing, etc...), attempts to write the data will generate a Writing error 
message. Try again later after the device goes into the standby condition.

Note:
When writing a data to the device by Address Book Editor, there is the case that the registration contents of the [Fax 
Forward] and [Program Key] set in the device may be changed depending on editing contents.
Please confirm the registration contents before you write the data, and reconfirm it after the data is written.
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Advanced Operation
Save a Retrieved Data File

To save the retrieved configuration data, click the  icon, or select Save As from the File menu.

1. Select an existing file from the list, or enter a new file name.

2. Click the OK  button. The data is saved to a file.

To Save a File:
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Open a Saved File

To open a saved file, click the  icon, or select Open from the File menu.

To open a file:

1. Select a file from the list.

2. Click the OK  button.
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Create a New File

The editing window opens.
Edit the required items.

The Save As window opens.
Enter a new file name.

Click the OK  button.

The File Information window opens.
Click  to select the Model Number and 
Communication Type of connection.
Enter the Device Name, Location and IP 
Address of the device (optional).
Enter the login Password (Application 
Password) of the device (optional).

Click the OK  button.

To create a new file, for example to register an 
address book without connecting to the device, 
click the  icon, or select New from the File 
menu.

Note:
 You can select FTP or HTTP/HTTPS for 
Communication Type.

 If you are using Windows Vista, you can enter an 
IPv6 address in the IP Address field by selecting 
HTTP/HTTPS for the Communication Type 
(maximum of 512 characters).
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Registering the Device Address List

To open the Device Address List, click the  icon.

Acquires the network address list of the Device Explorer.

Discards all changes and closes the window.

Accepts the changes, and closes the window.OK  button

Connects and displays the retrieved data of the selected Device Address.Connect  button

Deletes the selected Device Address.

Edits the current settings of the selected Device Address.Edit  button

Adds a new Device Address setting into the dialog box.Add  button

Acquire  button

Delete  button

Cancel  button

The Edit Device Address List displays.
Click the:
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Registering the Device Group List

To open the Device Group List, click the  icon.

The Group Name List displays the registered groups.
Click the:

New  button Creates a new group.
Enters a name and click the OK  button.

Update  button Changes the name of the selected group.
Enters a new name and click the OK  button.

Delete  button Deletes the selected group.
The Device Address List displays the addresses of registered devices.

Acquires your network address list that the Device Explorer detected.

The Group Members section displays registered addresses for the selected group.
Use the   buttons to add, or delete the selected address from the group members.

Acquire  button
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Using the Device Address List and Device Group List

The destination can be specified in the Address Book or Group List.

< Retrieving Data Message >

< Writing Data Message >

Destinations:
This options window shows the devices, and 
their IP addresses currently chosen.

Note:
Multiple destinations can be entered only when the 
Dept. Code is selected in the Transfer  Write 
menu.

Options...  button is shown when a writing option 
is available.

Manual Input tab:
Enter the device data manually, and then click 
the  button to add the address to 
the destination.

Device Address List tab:
The addresses registered in the Address List, 
and then Group List are shown.
Select an address, and add or delete it by 
clicking the Add  or  button.

Click the OK  button to return to the 
confirmation window.

The confirmation window appears before 
retrieving, or writing data.

Click the Change Dest.  button.

Note:
 You can select FTP or HTTP/HTTPS for Type.
 If you are using Windows Vista, you can enter an 
IPv6 address in the IP Address field by selecting 
HTTP/HTTPS for the Type (maximum of 512 
characters).
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Changing the Department Code Counter Data (Only for Network Configuration)

Follow the procedure below to write the Department Code Counter Data to the device.

Click the Options...  button.

Note:
Click the Options...  button, and then select Dept. 
Codes and Counter Data to write the Department 
Code Counter Data to the device.

Click the OK  button to return to the 
confirmation window.

Select Dept. Codes and Counter Data, and 

click the OK  button.

A confirmation window appears before writing 
data.

Click the Change Dest.  button.
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Using Timer Communication

Timer section:
Click Enable, and then select the time to start 
the communication.

Click the OK  button to create the job, 
and hold it in the spooler until the specified start 
time.

< Retrieving Data Message >

< Writing Data Message >

A confirmation window appears before 
retrieving, or writing data.

Click the Change Dest.  button.
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Cancel Timer Communication

If you need to cancel a job, select the job, and 
choose Delete from the Spooler menu.

Click the Spooler in the taskbar to open it.



24

U
sing C

onfiguration/
A

ddress B
ook Editor

Editing the Network Address Book Editor – Copy and Paste Address Book data

Open the source data file, and the target data file.
Refer to Open a Saved File, see page 16.
Select Window  Tile Horizontal.

Select the range that you want to copy.

Click on the first number that you want to copy 
from, and then click on the last number that you 
want to copy to, while pressing Shift key.
or
Click on the first number that you want to copy 
from, and drag the mouse to the last number 
you want to copy to.

Right-click on the selection, and then select 
Copy, or select Copy from the Edit menu.

Click on the number where you want to paste 
the data.

Right-click and select Paste, or select Paste 
from the Edit menu.
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Data is pasted at the designated location.

Note:
The data exceeding the maximum allowable number 
of address book entries will be lost.
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Editing Network Address Book Editor – Import Address Book data from other 
applications

Address Book data created using other applications, such as Microsoft Excel®, can be imported.

Data is pasted at the designated location.

Note:
The data exceeding the maximum allowable Number 
of Address Book entries will be lost.

Click on the Number where you want to paste 
the data.
Right-click and select Paste, or select Paste 
from the Edit menu.

Copy the Address Book data from the other 
application.
The data format must be an Address (IP 
Address/Fax Number/Email Address), and 
Destination Name.
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PANASONIC COMMUNICATIONS COMPANY OF NORTH AMERICA MAKES NO WARRANTIES, 
GUARANTEES OR REPRESENTATIONS, EXPRESSED OR IMPLIED, TO THE CUSTOMER WITH 
RESPECT TO THIS PANASONIC MACHINE, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

PANASONIC COMMUNICATIONS COMPANY OF NORTH AMERICA ASSUMES NO RISK AND SHALL 
NOT BE SUBJECT TO LIABILITY FOR ANY DAMAGE, INCLUDING, BUT NOT LIMITED TO DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSS OF PROFITS 
SUSTAINED BY THE CUSTOMER IN CONNECTION WITH THE USE OR APPLICATION OF THIS 
PANASONIC MACHINE. SEE YOUR DEALER FOR DETAILS OF DEALER’S WARRANTY.

USA Only

WARRANTY

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for
USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

I0305-13128 (07)
PJQMC0412UA
December 2008
Published in Japan

http://panasonic.co.jp/pcc/en/
http://www.panasonic.ca
http://panasonic.net
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